
Rafał Krenz Ground Sta�on CS.S4.Gen

This document contains the specifica�on of the ground sta�on for the C, UHF and VHF - bands 

Satellite Radio system.
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List of acronyms

CBSR C-band Satellite Radio
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1. Antenna System

An important component of the CBSR ground sta�on is the antenna system. It consist of the 3m 

parabolic antenna for C-band as well as Yagi antennas for VHF/UHF bands, installed on a masts 

located on the top of the 8-floor building of the Electrical Engineering Faculty. The antennas are able 

to track the satellite, which moves in the sky and visits the loca�on several �mes per day for a short 

period of 10-15 minutes.

1.1. C-band Subsystem

1.1.1. Parabolic antenna

The parabolic antenna used in CBSR ground sta�on is a 3m prime focus mesh dish, produced by RF 

HAMDESIGN B.V. and delivered as a "DO IT YOUR SELF KIT" [1]. The support is made of aluminum and

the mesh is made of galvanized steel (Fig. 1.1) The useable frequency of the dish with the 2.8mm 

mesh is 1 - 11GHz and F /D=0.4. The gain at 5.8GHz is 43dB and the -3dB angle is 1.3 deg.

Fig 1.1 3m prime focus mesh dish
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1.1.2. Septum feed

The parabolic antenna uses a feed to convert the electromagne�c waves energy to the electric 

current fed to the receiver. Since CBSR system uses circular polariza�on (LHCP/RHCP) to avoid 

antenna polariza�on misalignment loss, a septum type feed is used. The feed has been designed and 

built by Bert Modderman (call sign PE1RKI) [2], see Fig. 1.2. It has been tuned to 5840MHz center 

frequency and has a return loss ~25dB and LHCP/RHCP isola�on ~35dB. It can be mounted to the 

dish using a slightly modified CLX06 bracket from RH HAMDESIGN (Fig. 1.3).

Fig 1.2 6cm septum feed

Fig. 1.3 Feed bracket with the feed installed
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1.1.3. AZ&EL Rotator

For tracking the satellite an azimuth and eleva�on rotator is used. High precision BIG-RAS/HR rotator 

is a two engine rotator which has installed two posi�on sensors coun�ng 0.1 degree on impulse 

(Fig. 1.4). It is produced by a Polish company SPID Elektronik and delivered together with a MD-01 

Rotator Controller and PS-01 Dual Voltage Power Supply [3]. The rota�on range for AZ/EL is 360/180 

deg. with a 0.1 deg. resolu�on. The BIG-RAS/HR rotator is able to carry big dishes with diameter up 

to 6m.

The dish is coupled with the rotator using a heavy-duty moun�ng bracket with counter-weight arms 

UA-01 from SPID Elektronik (Fig. 1.4). It requires cheap and easy to buy exercise weights to be used 

as the counter-weights.

Fig. 1.4 SPID BIG-RAS/HR Rotator with moun�ng bracket

1.1.4. Antenna Pre-amplifier

The antenna pre-amplifier consists of a band-pass receiving filter and an LNA. The filter is a 

Mini-Circuits ZVBP-5800-S+ narrow-band, low inser�on loss cavity filter [4]. The pass band is 

5725-5875MHz with the inser�on loss of 0.8dB only (Fig. 1.5).
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Fig. 1.5 Typical performance of ZVBP-5800-S+ filter

The LNA is a C-band super low noise amplifier KU LNA 500590 A produced by Kuhne electronic GmbH

[5]. The typical gain is 28dB and the noise figure is as low as 1.5dB. The amplifier uses a remote 

power supply via RF output and a T-bias, located at the receiver site.

The pre-amplifier is protected by a water-proof housing, located close to the feed (Fig. 1.6). The 

amplified signal is fed to the main receiver site using a 20m feeder made with the LDF4-50A, 1/2” 

corrugated coaxial cable.

Fig. 1.6 Antenna pre-amplifier in a water-proof housing
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1.2. VHF/UHF-band Subsystem

The VHF/UHF-band subsystem is not a part of CBSR system, however, many Cubesats implements 

this form of communica�on links for telemetry and control. Since CBSR operates on the downlink 

only, another communica�on link is necessary for controlling the system. Therefore, CBSR system 

closely cooperates with other communica�on subsystems to transmit commands on the uplink.

1.2.1. Yagi antennas

Two separate high-gain Yagi antennas are used to establish bi-direc�onal communica�on with the 

Cubesat in VHF/UHF bands.

The uplink operates in 145MHz band and uses WX-220 antenna from WiMo Antennen und Elektronik

GmbH [6]. This is 2x10 element crossed Yagi (circular polariza�on) with 4.6m length, 12dBi gain and 

1200W PEP (Fig. 1.7).

The downlink operates in 432 MHz band and uses WX-7036 antenna from WiMo Antennen und 

Elektronik GmbH [6]. This is 2x18 element crossed Yagi (circular polariza�on) with 3.4m length, 14dBi

gain and 800W PEP (Fig. 1.7).

Fig. 1.7 Yagi antennas
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1.2.2. AZ&EL Rotator

Both Yagi antennas are mounted on a crossbar (Fig. 1.8) aAached to the high precision BIG-RAS/HR 

azimuth and eleva�on rotator (see 1.1.3).

Fig. 1.8 Yagi antenna rotator

1.2.3. Antenna Pre-amplifier

The UHF antenna uses the off-the-shelf SP-70 mast pre-amplifier from SSB-Electronic [7] (Fig. 1.9). It 

is designed to operate in 430 – 440MH frequency range with a variable 12 – 22dB gain and typical 

noise figure 0.7dB. The amplifier uses a remote power supply via RF output and a T-bias, located at 

the receiver site.

The VHF antenna uses the off-the-shelf SP-200 mast pre-amplifier from SSB-Electronic GmbH [7] 

(Fig.1.9). It is designed to operate in 144-146MH frequency range with a variable 10 – 20dB gain and 

typical noise figure 0.5dB. The amplifier uses a remote power supply via RF output and a T-bias, 

located at the receiver site.

The amplified signal is fed to the main receiver site using a 20m feeder made with the LDF5-50A, 7/8”

corrugated coaxial cable. The same type of feeder is used for both VHF and UHF antennas.
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Fig. 1.9 SP-70/SP-200 mast pre-amplifiers

1.3. Antenna support

The antenna system is located on the roof of the Electrical Engineering Faculty building (16° 57' 03" E,

52° 24' 07" N), roughly 35m above the ground. Two 3m high masts have been mounted, one for the 

C-band antenna subsystem and the other for VHF/UHF-band antenna subsystem (Fig. 1.10, Fig. 1.11).

The selected loca�on guarantees that there are no obstacles blocking the line-of-sight 

communica�on between the satellite and the ground sta�on antenna, even for very low eleva�on 

angles and 360 deg. azimuth.

Fig. 1.10 Antenna masts
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Fig. 1.11 Antenna system loca�on
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1.4. Other equipment

Since the antenna system is managed from the Control Centre, there is some addi�onal hardware 

installed close to the masts to support the remote control.

1.4.1. Weather sta.on

A Davis Vantage Pro2 Weather Sta�on (Fig. 1.12) is used to monitor the current weather condi�ons 

which may impact satellite signal recep�on. The sta�on monitors the following parameters: air 

temperature and humidity, barometric pressure, dew point, rainfall, wind speed and direc�on [8]. It 

is connected by wires to the interface located at the receiver site. The weather sta�on has a sta�c IP 

address, but all the data is sent to a remote server managed by Davis Instruments. Data collected by 

the weather sta�on can be accessed on the website www.weatherlink.com, username and a default 

password is required to successfully login.

Fig.1.12 Davis Vantage Pro2 Weather Sta�on

1.4.2. IP Camera

The HIK Vision HWP-N4215IH-DE IP camera (Fig. 1.13) is used to verify the opera�on of the antenna 

system. It is a 2.0 MP, 15× op�cal zoom, infrared speed dome camera with wide dynamic range, 

suppor�ng H.265+/H.265 video compression modes [9]. It is connected by wires to the Ethernet 

switch located at the receiver site and can be accessed via internet browser. Username and default 

password should be entered to have access to the video feed. Presets were set up for quicker 

transi�on between satellite dish, Yagi antennas and weather sta�on.
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Fig.1.13 HIK Vision HWP-N4215IH-DE IP camera

1.4.3. LED lamps

The antenna system can be illuminated to allow visual observa�on during the night by two 7000lm 

LED lamps, which can be remotely switched on-off from the Control Centre. LED floodlights are 

connected to the IP Power Socket to the fiUh socket from the leU.
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2. Transceiver Sta.on

The transceiver sta�on is located in the aVc of the Electrical Engineering Faculty building, as close to 

the antenna system as possible to minimize cable losses.

All the components of the transceiver sta�on are enclosed in a single 19” 27U floor-standing rack 

cabinet (Figs. 2.1-2.2).

Fig. 2.1 Transceiver sta�on – front
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Fig. 2.2 Transceiver sta�on – back
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2.1. Rotator Controller

The MD-01 Rotator Controller controls the antenna rotator. It has a build in backlight display which 

shows Azimuth & Eleva�on in real �me at 0.1 degree resolu�on (Fig. 2.2). This means the rotator can 

also be used as a stand-alone configura�on and the Azimuth & Eleva�on engine can be moved using 

the arrow buAons on the front panel. The menu can also be entered on the front panel and changes 

can be made to all available func�ons. The controller can handle 2 rotor systems, this means it can 

also drive two azimuth or two eleva�on rotators or one Az/El rotator at the same �me. Build in the 

controller is also a track interface which can be connected through USB or Ethernet interfaces.

The controller supports the following soUware:

✓ PST Rotor (Also /HR controllers MD-0X)

✓ MacDoppler (MacDoppler Ham Radio Satellite Tracking for Macintosh)

✓ N1MM Logger

✓ Ham Radio Deluxe

✓ Logic 7 Version => 7.0.45

✓ Orbiton Satallite Tracking

✓ Gpredict Satallite Tracking Linux and MAC

✓ SatPC32 Satallite Tracking - works on windows only

✓ DXLab (DX View)

✓ TRXmanager

Since two rotators are used, one for the C-band antenna and the other for VHF/UHF-band antennas, 

two MD-01 controllers (2 x 1U) are installed in the cabinet.

To control these rotators remotely they have to be set to allow remote connec�ons via Internet, for 

that enter seVngs (S buAon), select Motor configura�on (S buAon), find CONTROL AE seVngs and 

set it to ETH. Save seVngs and exit from the configura�on menu.

Fig. 2.2 MD-01 Rotator Controller

2.2. Power Supply

The PS-01 Power Supply Module is a dual voltage PSU, designed to work with high resolu�on rotator 

system SPID BIG-RAS/HR (Fig. 2.3). It delivers 15V/10A and a 22V/22A.

Since two rotators are used, one for the C-band antenna and the other for VHF/UHF-band antennas, 

two PS-01 power supply modules (2 x 1U) are installed in the cabinet.

Fig. 2.3 PS-01 Dual Power Supply
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2.3. PCs

There are two (op�onally – three) personal computers installed in the cabinet. All the PCs have the 

same configura�on:

✓ AMD Ryzen 5 3600 CPU

✓ 16GB RAM

✓ 1TB SSD

✓ 4TB HDD

✓ 500W PSU

✓ mini-ITX housing

One of the PC’s is configured as the SDR receiver for the C-band Satellite Radio. It uses EAus Research

USRP B210 as the radio front-end. The other PC is configured as the SDR receiver for the UHF-band 

satellite communica�on system. It uses FunCube Dongle as the radio front-end. It is also connected 

via USB to the VHF transceiver (see below) and acts as the SDR transmiAer for the VHF uplink.

2.4. VHF/UHF Transceiver

The uplink communica�on with the Cubesat is implemented using off-the-shelf ICOM IC-9700 radio 

amateur transceiver (Fig. 2.4). It is an all mode Tri-band transceiver, covering 2 m, 70 cm, and 23 cm. 

In addi�on to the tradi�onal SSB, AM, FM, CW, and RTTY modes, the transceiver also incorporates 

D-STAR DV and DD modes. The power amplifier outputs stable power with high efficiency (144/430 

MHz band: 100/75 waAs).

The transceiver uses a PS-30SW5 14.4V/30A power supply and is operated remotely from the Control

Centre via Ethernet.

Fig. 2.4 IC-9700 Transceiver

NOTE: This is a temporary solu�on – the transceiver should be replaced by the SDR transmiAer with a

VHF power amplifier to allow higher bit rates on the uplink.

2.5. Weather Sta.on Interface

The Davis Instruments' Weather Envoy provides a way of geVng weather data from the Vantage 

Pro2 weather sta�on into the computer using the provided WeatherLink soUware. The Weather 

Envoy includes the data collec�on and logging func�ons of the Vantage Pro2 console.

The interface is located in the cabinet and connected to the Control Centre via Ethernet.
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2.6. Network A8ached Storage

The data collected from the Cubesat is stored on a Synology DS410 Network AAached Storage, 

located in the cabinet.

2.7. Ethernet Switch

As already men�oned, the receiving sta�on and the antenna system is managed remotely from the 

Control Centre. It uses the Planet FGSW 2620VMP4 Ethernet switch located in the cabinet (1 x 1U) to 

connect all the devices to the PUT local area network. The following devices are connected to the 

switch:

✓ 2 rotator controllers

✓ 3 PCs

✓ weather sta�on interface

✓ IP camera

✓ NAS

✓ 2 managed IP power sockets

✓ VHF/UHF transceiver

2.8 Managed IP Power Socket

All devices located in the cabinet (excluding the Ethernet switch) are connected to 230VAC via two IP 

power sockets 6G10A. The sockets are managed via Ethernet from the Control Centre. This makes 

remote restar�ng of all the devices possible in case of any failure. Both of the IP sockets have web 

interface, watchdog (automa�c on/off switch in case of ping failure), SMTP no�fica�ons, SNMP and 

sensors to probe temperature and react on triggers.

Equipment connected to the Upper IP Power Socket, from leU to right is the following:

� Power supply for rotators

� Power supply for rotators

� TransmiAer

� <empty>

� Cooling fans

� Laptop for local configura�on of servers

Equipment connected to the Lower IP Power Socket, from leU to right is the following:

� Power supply for preamplifiers

� Network access storage

� Windows Server

� Ubuntu Server

� LED Floodlights

� Weather sta�on
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3. Control Centre

The ground sta�on is managed from the control center located in room P019 in the building of 

Compu�ng and Telecommunica�on Faculty.

The control sta�on consists of two personal computers and four displays (Fig. 3.1). The computers 

are connected to PUT local area network and uses VLAN connec�on to communicate with the 

receiving sta�on. The contents shown on the displays is configurable; typical configura�on is the 

following:

✓ display 1 – Ham Radio Deluxe soUware used for tracking the satellite (other soUware may be used 

as well)

✓ display 2 – view from the IP camera, weather sta�on informa�on

✓ display 3 – communica�on soUware (telemetry readouts, commands sent, etc.)

✓ display 4 – VHF/UHF transceiver front panel

Fig. 3.1 Control sta�on displays
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All communica�on using amateur bands is done using call-sign SP3PET, belonging to the Amateur 

Radio Club associated to Poznan University of Technology.

Computers are configured to turn on as soon as power is returned. This is done to mi�gate the 

down�me of the servers if power is suddenly lost. To further reduce down�me Wake on LAN (WoL) is

configured and sleep mode is turned off. Computers are also connected to the IP Power Socket, 

which can monitor and control power to computers automa�cally as well as manually via remote 

control.

The two PCs works as servers (with no display/keyboard/mouse aAached) and they are managed 

remotely from the Control Centre, using remote desktop protocol. However, local control is possible 

as well via a terminal (a laptop) located in the cabinet.

Each computer can be accessed using remote desktop protocol. For various devices which do not 

need sta�c IP address DHCP service is available.

To extend the ability for remote connec�on to PCs a VPN PPTP connec�on can be configured. To do 

it on Windows 10, the following steps have to be done:

1. Click “Add a VPN connec�on” in “VPN” of the “Network and Internet” seVngs.

2. Choose “Windows (built-in)” as VPN provider, type user-friendly name in “Connec�on 

Name”, save.

3. In “Change adapter op�ons” right-click newly created adapter and select “Proper�es”.

4. In Security tab choose PPTP as Type of VPN and choose to Require encryp�on as Data 

encryp�on.

5. In Networking tab select TCP/IPv4, choose Proper�es and click “Advanced” buAon, unmark 

“Use default gateway on remote network” and ensure “Disable class based route” addi�on is

unmarked (unmark it otherwise), save all changes.

When VPN connec�on is established, the PCs can be accessed via DNS name, which will be resolved 

to computer’s IP.
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4. Structure of IP network

IP addresses are assigned by DHCP on the router for devices with dynamic IP addresses. The 

following devices have a sta�c IP address or IP address is reserved via MAC address of the device:

Name of the device

Switch

Windows 11 control center

Windows 11 remote server (na�ve)

Windows 11 control center

Ubuntu remote server

ICOM IC-9700 transceiver

Synology DS410 NAS

Windows 11 remote server (virtual OS)

Weather sta�on

IP camera

IP Power Socket (upper)

IP Power Socket (lower)

Electronic driver for rotors (dish antenna)

Electronic driver for rotors (Yagi antenna)

Router

To remotely access devices or login to the websites username and password is required.
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Appendix A

An addi�onal informa�on is provided below about configura�on of HAM Radio Deluxe (HRD)

Ini�al configura�on

Upon the start of the HAM Radio Deluxe a window will open with defined presets and a possibility to 

create a new defini�on, to connect to IC-9700 following op�ons were chosen:

� Company: ICOM

� Radio: IC-9700

� COM port: COM3

� Speed: 19200

� CI-V: A2

Every other op�on was leU as default.

The locator of the sta�on has to be set to have a correct loca�on of the sta�on on the map, to do so 

following steps have been performed:

� Open HAM Radio Deluxe

� Open Logbook program from HAM Radio Deluxe

� Go to Tools -> Configure -> My Sta�on

� Set the locator to JO82LJ, which corresponds to the actual loca�on square of the sta�on

Since both rotators are accessible via Ethernet and HAM Radio Deluxe is able to connect to rotators 

only via COM ports, we need an addi�onal program which will perform the conversion, currently it is 

Virtual Serial Ports Emulator (VSPE)

To configure virtual COM port in VSPE (in case of non configured VSPE client presets on the 

desktop -> normally skip this part):

� Device -> Create -> Connector, any non-existent COM number can be chosen, like COM15

� Device -> Create -> TCP Client

� Source serial port: COM15 or the one which was created via first step

� Emula�on -> Start

AUer both Status messages are OK, HAM Radio Deluxe can be configured to connect to virtual COM 

port.

Configuring Rotators

For tes�ng purposes, the satellite which will be tracked is ISS, in order to select it:

From HAM Radio Deluxe open Satellite Tracking

� Click New Satellite -> ISS (The informa�on about ISS and its current loca�on will be displayed 

on the map)
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� To see informa�on about the loca�on of the satellite on the radar, an overlay can be enabled

by going to Satellite -> Radar Plot

� Click Rotator -> Enable and Rotator -> Start

� Click Tuning Dial and Enable RX

From HRD Satellite Tracking go to Rotator or from HRD Rig Control go to Rotor Display:

� Select HRD SatTrack

� Click DDE: Connect

� Rotator: AlfaSpid RAS Az/El

� Protocol: AlfaSpid

� Port: COM2

� Speed: 19200

� Refresh rate: 2 sec

� Stop posi�on: Controller Managed

� Click Connect

� DDE update every: 1 sec

� Step size: 1 degree

� When ready, click DDE: Track

An addi�onal informa�on is provided below about configura�on of SDR Radio Console v3

Ini�al configura�on:

� Connect FUNCube dongle first

� When star�ng SDR Console for the first �me a window will show up that no defini�ons are 

found, click Defini�ons...

� Search -> FUNcube and add the device

� Select Soundcard and click start

Locally it works, but to have remote access we need to set up a server:

� Tools -> Server Manager

� Accounts -> Add, provide username and the default password, some appropriate comment, 

do not limit maximum connec�on �me or have interval between connec�ons

� Radios -> Defini�ons, add FUNcube radio as it was done previously

� Firewall -> Add, for addi�onal security whitelist connec�ons

� Network -> Windows Firewall -> Add port

� Welcome Text can be edited

� Service -> Install and Start if needed, be sure to check that Start service when Windows starts

is selected

Server side done, now to configure remote host:

� Install SDR Console v3 on remote host
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� Start SDR Console v3 -> Select Radio -> Radio Defini�ons -> Search -> V3 Server

� Search -> Select FUNcube -> OK

� Add 1 device to the list -> Save

� Select Radio -> Select FUNcube -> Connect

� Soundcard: Line (FUNcube Dongle V2.0)

� Bandwidth: any, can be changed later

Appendix B

Setup of ICOM transceiver for remote connec�on through Ethernet port (with local LAN network):

� 2nd DNS Server: (undefined)

� Network Control: ON

� Power Off SeVng: Standby/Shutdown

� Internet Access Line: FTTH

� Network User 1 Administrator: YES

� Network User 2 Administrator: YES

� Network Radio Name: IC-9700

Setup of Remote U�lity so1ware for remote connec�on through Ethernet port (with local LAN 

network) on CBSR-2 computer:

� Virtual COM Port Number: COM 12

� Speaker: Realtek HD Audio 2nd Output (in case of use local computer soundcard) or Remote 

Audio (in case of use sound redirec�on to remote/access computer)

� Mic: Default Device

Setup of Remote Controller so1ware for remote connec�on through Ethernet port (with local LAN 

network) on CBSR-2 computer:

� Connec�on: LAN

� COM Port: 12

� MOD Select: LAN

Appendix C

Configura�on of the SPID MD-01 DDE program to connect to the SPID MD-01 posi�oner:
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Motor tab:

� Template: -> 1:AZ, 2:EL

� Control AE (top row): -> USB

� Protocol AE (top row): -> SPID ROT2

� Control AE (lower row): -> NONE

� Protocol AE (lower row): -> NONE

ATTENTION!!!

Never select the op�on: Control AE -> ETH, because it may disconnect the posi�oner controller and 

the necessity to manually configure the seVngs using the front panel of the device. Although the 

en�re controller is physically connected to the LAN via the Ethernet port, it uses an internal 

expansion card (network) that communicates with the controller using USB interface emula�on - 

hence it is necessary to configure the SPID MD-01 DDE program to use the standard USB 

communica�on, despite the lack of physical use of the controller's USB port

Ports -> COM 0 tab:

� State: -> OFF

� Baud: -> 115 200

� Data bits: -> 8

� Stop bits: -> 1

� Parity: -> NONE

Ports -> COM 1 tab:

� State: -> OFF

� Baud: -> 115 200

� Data bits: -> 8

� Stop bits: -> 1

� Parity: -> NONE

Ports -> USB COM tab:

� State: -> ON

� Baud: -> 460 800

ATTENTION!
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It is necessary to enable communica�on via the emulated USB port, even when using a physical 

Ethernet connec�on!

In case of mistakenly changing the connec�on parameters, read the values from the page. The 

KRISTECH network card integrated in the SPID MD-01 controller uses Port 0 to emulate a USB 

connec�on with connec�on speed parameters of 460 800 - it is possible to change the card's 

transmission speed, but then it is necessary to adjust the transmission speed in the SPID MD-01 DDE 

program.

Ports -> ETHERNET tab:

� State: -> OFF

TIP!

Azimuth and eleva�on values displayed by the controller in the range <0 degrees; 359 degrees > 

means the basic range of antenna movement - full rota�on. Values between <0 degrees; +180 

degrees> means that the antenna makes a second turn - aUer the basic 360 degree turn, it makes 

another half turn of an addi�onal 180 degrees, so the total rota�on of the antenna is 540 degrees. 

Values <-180 degrees; 0 degrees > means that the antenna can make half a full turn in the opposite 

direc�on from the ini�al posi�on (so 0 degrees)

Configura�on of the SPID MD-01 DDE program in order to load data (se6ngs) to the memory of 

the SPID MD-01 posi�oner controller:

Motor tab:

� Template: -> 1:AZ, 2:EL

� Control AE (top row): -> USB

� Protocol AE (top row): -> SPID ROT2

� Control AE (lower row): -> NONE

� Protocol AE (lower row): -> NONE

ATTENTION!!!

Never select the op�on: Control AE -> ETH, because it may disconnect the posi�oner controller and 

the necessity to manually configure the seVngs using the front panel of the device. Although the 

en�re controller is physically connected to the LAN via the Ethernet port, it uses an internal 

expansion card (network) that communicates with the controller using USB interface emula�on - 

hence it is necessary to configure the SPID MD-01 DDE program to use the standard USB 

communica�on, despite the lack of physical use of the controller's USB port

Ports -> COM 0 tab:
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� State: -> OFF

� Baud: -> 115 200

� Data bits: -> 8

� Stop bits: -> 1

� Parity: -> NONE

Ports -> COM 1 tab:

� State: -> OFF

� Baud: -> 115 200

� Data bits: -> 8

� Stop bits: -> 1

� Parity: -> NONE

Ports -> USB COM tab:

� State: -> OFF

� Baud: -> 460 800

Ports -> ETHERNET tab:

� State: -> ON

ATTENTION!

The "State" value must be set to ON, because the controller communicates with the management 

soUware and the PC via the Ethernet port!

ATTENTION!

When seVng the parameters of the maximum angles of the antenna "Min angle" and "Max angle" 

using the SPID MD-01 DDE program and other parameters of the controller, remember that before 

star�ng the procedure of loading data to the controller's memory (using the "Upload" func�on) in 

the program SPID MD-01 DDE specify all the above values in accordance with this sec�on of the 

manual (used ports and data transmission protocols).

TIP!

Azimuth and eleva�on values displayed by the controller in the range <0 degrees; 359 degrees > 

means the basic range of antenna movement - full rota�on. Values between <0 degrees; +180 

degrees> means that the antenna makes a second turn - aUer the basic 360 degree turn, it makes 

another half turn of an addi�onal 180 degrees, so the total rota�on of the antenna is 540 degrees. 

Values <-180 degrees; 0 degrees > means that the antenna can make half a full turn in the opposite 

direc�on from the ini�al posi�on (so 0 degrees)
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In order for the configura�on changes made in the SPID MD-01 DDE program to be saved in the 

controller (posi�oner), it is necessary to use the "Upload" buAon

Configura�on of se6ngs on the front panel of the SPID MD-01 posi�oner:

MOTOR CONFIGURATION tab:

� TEMPLATE: -> 1:AZ, 2:EL

� CONTROL AE: -> ETH

� PROT. AE: -> SPID ROT2

ATTENTION!!!

In order for the controller to be able to communicate via the Ethernet module, it is necessary to 

select the CONTROL AE: -> ETH op�on, otherwise it will not be possible to establish communica�on 

with the controller via the Ethernet port (although in the controlled program SPID MD-01 DDE the 

op�on of control via USB port).

SET COM 0 tab:

� STATE: -> OFF

� BAUD: -> 115 200

� DATA BITS: -> 8

� STOP BITS: -> 1

� PARITY: -> NONE

SET COM 1 tab:

� STATE: -> OFF

� BAUD: -> 115 200

� DATA BITS: -> 8

� STOP BITS: -> 1

� PARITY: -> NONE

SET USB COM tab:

� STATE: -> OFF

� BAUD: -> 460 800

ATTENTION!
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It is necessary to set the STATE func�on: -> OFF, because the physical connec�on with the posi�oner 

is via the Ethernet port, while the physical USB port is not in use (although its emula�on is necessary 

in the SPID MD-01 DDE control program). BAUD speed: -> 460 800 must be consistent with the 

seVngs of the KRISTECH network card implemented in the posi�oner and with the seVngs of the 

USB port speed in the SPID MD-01 DDE control program.

SET ETHERNET tab:

� STATE: -> ON

ATTENTION!

The "STATE" value must be set to "ON" to enable communica�on via the Ethernet port and thus 

enable remote control of the posi�oner via LAN.

TIP!

Azimuth and eleva�on values displayed by the controller in the range <0 degrees; 359 degrees > 

means the basic range of antenna movement - full rota�on. Values between <0 degrees; +180 

degrees> means that the antenna makes a second turn - aUer the basic 360 degree turn, it makes 

another half turn of an addi�onal 180 degrees, so the total rota�on of the antenna is 540 degrees. 

Values <-180 degrees; 0 degrees > means that the antenna can make half a full turn in the opposite 

direc�on from the ini�al posi�on (so 0 degrees)

Appendix D

Configura�on of the HRD Rotator program to work with the SPID MD-01 posi�oner controller:

� Rotator: AlfaSpid RAS Az/El

� Protocol: AlfaSpid

� Port: COM2

� Speed: 19200

� Refresh rate: 2 sec

� Stop posi�on: Controller Managed

Appendix E

Instruc�ons for star�ng the Yagi antenna rotor (UHF/VHF band) in the automa�c satellite tracking 

mode using the SDR Console so1ware:
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� Run the VSPE program using the file "HRD rotator both config.vspe" placed on the desktop

� Emula�on of COM and TCP ports should be ini�alized automa�cally (in the absence of 

ini�aliza�on, press the "Start emula�on" buAon)

� Wait un�l all TCP and COM ports are "OK"

� Then minimize the VSPE window, but do not close it with the "X" buAon

� Launch SDR Console

� In the "Select radio" dialog box, select "Line (FUNcube Dongle V2.0)" in the "Soundcard" field

and press the "Start" buAon. The Fun Cube Dongle radio receiver will then be ini�alized and 

thus start receiving the signal on the set frequency

� ATTENTION!

� Star�ng the receiver is necessary to unlock the ability to automa�cally track and control the 

antennas!

� In the "View" tab, launch the dedicated satellite module "Satellites"

� In order to select a specific satellite, go to the "Satellite List" tab, and then select a specific 

satellite from the list

� ATTENTION!

� The receiver's carrier frequency, modula�on mode and bandpass filter width will be set 

automa�cally depending on the selected satellite

� ATTENTION!

� If the satellite you are looking for is not visible in the satellite selec�on tab, enter the "Select"

op�on and then select the specific satellite. Satellites with an eye icon are visible at a specific

point in �me, allowing you to start tracking immediately. Double-clicking on a specific 

satellite from the list causes its selec�on and automa�c tuning of all receiver parameters

� Run HRD Rotator.

� In the satellite module of the SDR Console, select the "Enable Tracking" op�on, thanks to 

which the data will be sent to the HRD Rotator using the DDE client. Ac�ve data transmission 

from the SDR Console program will be visible on the boAom bar of the screen map, where 

the parameters "AZ" - azimuth and "EL" - eleva�on will be updated

� In the HRD Rotator, make sure that the "Orbitron" communica�on protocol (DDE client) is 

selected, and then ac�vate the "DDE Connect" buAon. Then the buAon icon will be 

highlighted, which will indicate data transmission between the SDR Console and HRD Rotator

soUware

� Next, ac�vate the Connect buAon - the correct connec�on with the posi�oner will be 

confirmed by replacing the buAon with the "Disconnect" buAon

� In order to start tracking the satellite, ac�vate the "DDE Track" buAon - the tracking 

procedure will be started and the antenna system will follow the trajectory of the selected 

satellite.

ATTENTION!

AUer the communica�on session ends and satellite tracking is complete, the antennas will return to 

their home posi�on (0 degrees azimuth and 0 degrees eleva�on). In order for the antennas to return 

to their ini�al posi�on, the "Enable Tracking" func�on in the SDR Console must be turned off

Version 1.0.3 - Public 20.11.2020 31



Rafał Krenz Ground Sta�on CS.S4.Gen

ATTENTION!

Satellite tracking is possible only when the eleva�on value is greater than 0 degrees! If you select a 

satellite whose eleva�on value at a specific moment is less than or equal to 0, the antenna will set 

itself in the posi�on from which the satellite will be visible during the next flight. Selec�ng another 

satellite from the list during ac�ve tracking ("Enanle Tracking" op�on ac�ve) will result in poin�ng 

the antenna to the beginning of the trajectory of another satellite or its ac�ve tracking (if it is visible)

ATTENTION!

The SDR Console program, while ac�vely tracking the satellite, also performs the Doppler effect 

compensa�on by retuning the receiver for the frequency devia�on resul�ng from the calculated 

satellite movement trajectory!

ATTENTION!

TLE files used to predict the posi�on of the satellite and determine the tracking path are updated 

from online databases automa�cally and in the background

ATTENTION!

Never run "spidMD01dde" when port emula�on in VSPE is ac�ve!!!

Appendix F

Instruc�ons for star�ng the Yagi antenna rotor (UHF/VHF band) in the automa�c satellite tracking 

mode using the HRD Satellite Tracking program:

� Run the VSPE program using the file "HRD rotator both config.vspe" placed on the desktop
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� Emula�on of COM and TCP ports should be ini�alized automa�cally (in the absence of 

ini�aliza�on, press the "Start emula�on" buAon)

� Wait un�l all TCP and COM ports are "OK"

� Then minimize the VSPE window, but do not close it with the "X" buAon

� Launch the HRD Satellite Tracking program

� In the "Satellite" tab, select the satellite that is currently visible (visibility �me will be marked 

with the abbrevia�on LOS).

� Then check the "RX" box - it is necessary to transfer tracking data to the HRD Rotator 

module, and thus the correct opera�on of the tracking mechanism.

� AUer checking the "RX" box, select "Enable" from the drop-down menu aAached to the 

"Rotator" buAon.

� HRD Rotator should start automa�cally.

� In the HRD Rotator, ac�vate the "DDE Connect" buAon. Then the buAon icon will light up, 

which will indicate data transmission between HRD Satellite Tracking and HRD Rotator

� Next, ac�vate the Connect buAon - the correct connec�on with the posi�oner will be 

confirmed by replacing the buAon with the "Disconnect" buAon

� In order to start tracking the satellite, ac�vate the "DDE Track" buAon - the tracking 

procedure will be started and the antenna system will follow the trajectory of the selected 

satellite.

ATTENTION!

AUer the communica�on session ends and satellite tracking is completed, the antennas remain in the

posi�on where tracking was completed.

To park the antennas (Azimuth: 0 degrees, Eleva�on: 0 degrees):

� Turn off and completely close HRD Rotator and HRD Saellite Tracking

� Stop emula�on of ports in VSPE by clicking on the "Stop emula�on" buAon

� Run posi�oner management program "spidMD01dde"

� In the "spidMD01dde" program, go to the "Op�ons" tab and make sure that the program has

established a connec�on with the posi�oner controller. If the connec�on is established, the 

"Disconnect" buAon will be displayed. If the "Connect" buAon appears, ac�vate it - then the 

current seVngs of the posi�oner and the posi�on of the antennas will be downloaded to the 

program.

� In order to set the antennas to the ini�al value, enter "0" in the "M1" and "M2" fields, and 

then click the "Send" buAon.

� The antennas should return to their ini�al posi�on, which will be visible in the control field 

(green), displaying the current posi�on of the antennas in the eleva�on plane - the value 

"E2" and the azimuth "A1". Values are in degrees.

ATTENTION!

Never run "spidMD01dde" when port emula�on in VSPE is ac�ve!!!

Appendix G

Manual of the power-on computers remotely by LAN (CBSR-1, CBSR-2, CBSR-3, CBSR-4) with use 

Windows command tool "wolcmd.exe"

� Open the command prompt
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� Type command: wolcmd adress_MAC adress_IP subnet_mask port

which "adress_MAC" = xxyyzzaabbcc

                  "adress_IP" = ddd.eee.f.ggg

                          "subnet_mask" = hhh.iii.jjj.kkk

                          "port" = m

� Press Enter

ATTENTION!

This program sends power-on packet to boot up remote computer with use broadcast address, based

on subnet mask and IP address

It's necessary to type MAC adres in followed format -> xxyyzzaabbcc (small leAers)

For example:

C:\Users\CBSR-1>wolcmd xxyyzzaabbcc ddd.eee.f.ggg hhh.iii.jjj.kkk m

Appendix H

Manual of the power-on computers remotely by LAN (CBSR-1, CBSR-2, CBSR-3) with use Linux 

console tool "wakeonlan"

� Open the text terminal ("Terminal")

� Type command: wakeonlan adress_MAC

which "adress_MAC" = xx:yy:zz:aa:bb:cc

� Press Enter

It's necessary to type MAC adres in followed format -> xx:yy:zz:aa:bb:cc

For example:

cbsr-4@CBSR-4:~$ wakeonlan xx:yy:zz:aa:bb:cc

Appendix I

Instruc�ons for star�ng the UVSQ-SAT telemetry decoder

� Run the VSPE program using the file "HRD rotator both config.vspe" placed on the desktop
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� Emula�on of COM and TCP ports should be ini�alized automa�cally (in the absence of 

ini�aliza�on, press the "Start emula�on" buAon)

� Wait un�l all TCP and COM ports are "OK"

� Then minimize the VSPE window, but do not close it with the "X" buAon

� Launch SDR Console

� In the "Select radio" dialog box, select "Line (FUNcube Dongle V2.0)" in the "Soundcard" field

and press the "Start" buAon. The Fun Cube Dongle radio receiver will then be ini�alized and 

thus start receiving the signal on the set frequency

� ATTENTION!

� Star�ng the receiver is necessary to unlock the ability to automa�cally track and control the 

antennas!

� In the "View" tab, launch the dedicated satellite module "Satellites"

� In order to select a specific satellite, go to the "Satellite List" tab, and then select the UVSQ-

SAT satellite

� ATTENTION!

� The carrier frequency of the receiver and the modula�on mode will be set automa�cally 

aUer selec�ng the satellite!

� In the main window of the SDR Console program ("Filter" receiving filter width control 

sec�on), select a filter width of 20 kHz

� ATTENTION!

� If the satellite you are looking for is not visible in the satellite selec�on tab, enter the "Select"

op�on and then select the specific satellite. Satellites with an eye icon are visible at a specific

point in �me, allowing you to start tracking immediately. Double-clicking on a specific 

satellite from the list causes its selec�on and automa�c tuning of all receiver parameters

� Run HRD Rotator

� Run the Sound Modem program in the "BPSK (NRZI) - 9600 bps - only" version

� Make sure that the demodulated (audio) signal is transferred from SDR Console to Sound 

Modem - check the spectrogram plot in Sound Modem (it should have the same spectrum as 

the spectrogram in SDR Console)

� Run the UVSQ-SAT telemetry decoder contained in the "Telemetry decoder - UVSQ-SAT" 

folder. To do this, run the file "launchUVSQSat.bat"

� In the satellite module of the SDR Console program, select the "Enable Tracking" op�on, 

thanks to which the data will be sent to the HRD Rotator program using the DDE client. 

Ac�ve data transmission from the SDR Console program will be visible on the boAom bar of 

the screen map, where the parameters "AZ" - azimuth and "EL" - eleva�on will be updated

� In the HRD Rotator, make sure that the "Orbitron" communica�on protocol (DDE client) is 

selected, and then ac�vate the "DDE Connect" buAon. Then the buAon icon will be 

highlighted, which will indicate data transmission between the SDR Console and HRD Rotator

soUware

� Next, ac�vate the Connect buAon - the correct connec�on with the posi�oner will be 

confirmed by replacing the buAon with the "Disconnect" buAon

� In order to start tracking the satellite, ac�vate the "DDE Track" buAon - the tracking 

procedure will be started and the antenna system will follow the trajectory of the selected 

satellite.

� Press the Start buAon in the UVSQ-SAT telemetry decoder program. If you are successfully 

connected to Sound Modem, you should see "Connected to modem" at the boAom of the 

program window. The data decoding process should start successfully.
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ATTENTION!

AUer the communica�on session ends and satellite tracking is complete, the antennas will return to 

their home posi�on (0 degrees azimuth and 0 degrees eleva�on). In order for the antennas to return 

to their ini�al posi�on, the "Enable Tracking" func�on in the SDR Console must be turned off

ATTENTION!

Satellite tracking is possible only when the eleva�on value is greater than 0 degrees! If you select a 

satellite whose eleva�on value at a par�cular moment is less than or equal to 0, the antenna will set 

itself in the posi�on from which the satellite will be visible during the next flight. Selec�ng another 

satellite from the list during ac�ve tracking ("Enable Tracking" op�on ac�ve) will result in direc�ng 

the antenna to the beginning of the trajectory of another satellite or its ac�ve tracking (if it is visible)

ATTENTION!

During ac�ve satellite tracking, the SDR Console program also performs Doppler effect compensa�on

by retuning the receiver for the frequency devia�on resul�ng from the calculated satellite movement

trajectory!

ATTENTION!

TLE files used to predict the posi�on of the satellite and determine the tracking path are updated 

automa�cally and in the background from online databases

ATTENTION!

Never run "spidMD01dde" when port emula�on in VSPE is ac�ve!!!
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